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1 Introduction

This guide contains information on the Aperio ImageScope DX viewing software, which is part of the Aperio 
AT2 DX System. Aperio ImageScope DX enables you to view eSlides created by the Aperio AT2 DX scanner 
for the purpose of performing a primary diagnosis.

Your Aperio AT2 DX Viewing Stations come with Aperio ImageScope DX installed. 

Intended Use
The Aperio AT2 DX System is an automated digital slide creation and viewing system. The Aperio AT2 DX System is 
intended for in vitro diagnostic use as an aid to the pathologist to review and interpret digital images of surgical pathology 
slides prepared from formalin-fixed paraffin embedded (FFPE) tissue. The Aperio AT2 DX System is not intended for use with 
frozen section, cytology, or non-FFPE hematopathology specimens. 

The Aperio AT2 DX System is composed of the Aperio AT2 DX scanner, the Aperio ImageScope DX review application 
and display. The Aperio AT2 DX System is for creation and viewing of digital images of scanned glass slides that would 
otherwise be appropriate for manual visualization by conventional light microscopy. It is the responsibility of a qualified 
pathologist to employ appropriate procedures and safeguards to assure the validity of the interpretation of images obtained 
using the Aperio AT2 DX System.

Image Viewing Restrictions for Primary Diagnosis
The images produced by the Aperio AT2 DX are for diagnostic use within the Aperio AT2 DX System only. Images opened 
outside the system with non-cleared Aperio viewers will display an error alerting the user that these images cannot be used 
for primary diagnosis. 

Non-cleared Aperio viewers include:

`` Aperio ImageScope (all non-DX versions)

`` Aperio WebViewer

`` Aperio WebScope

`` Aperio ePathViewer

Supported Image Types
For primary diagnosis procedures, Aperio ImageScope DX supports only SVS files created by the Aperio AT2 DX scanner.

Aperio ImageScope DX enables you to open TIFF files for non-diagnostic purposes only. The pan and zoom features are not 
available when viewing a TIFF file.
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Aperio AT2 DX Viewing Stations and Monitors
Your Aperio AT2 DX System comes with a local Aperio AT2 DX Viewing Station that is connected to the Aperio AT2 DX 
scanner, and one or more Aperio AT2 DX Viewing Stations used to read eSlides created by the Aperio AT2 DX. Only the 
Aperio ImageScope DX viewing software and the Aperio AT2 DX Viewing Stations and medical-grade, calibrated monitors 
that you receive as part of the Aperio AT2 DX System are supported for primary diagnosis.

As part of monthly maintenance, we recommend that you do a visual quality check of your monitors once a month. See 
“Appendix A: Perform a Monitor Quality Check” on page 38 for complete instructions.

Aperio AT2 DX System Information
This Aperio ImageScope DX User’s Guide contains details on viewing Slides created by the Aperio AT2 DX using the Aperio 
ImageScope DX viewing software.  For further information, see:

`` Aperio AT2 DX System Overview for information on the entire Aperio AT2 DX System. 

`` Aperio AT2 DX User’s Guide for information on using the Aperio AT2 DX scanner.
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2
Aperio ImageScope DX 
Overview and Quick 
Reference

This chapter includes an overview of the  interface, along with quick reference information for the 
navigation and annotation tools. 

For instructions on how to view and annotate eSlides, see "Chapter 3: Basic eSlide Viewing" on page 19 and "Chapter 
4: View and Annotate eSlides" on page 23.  

Open a Case in Aperio ImageScope DX
You open a case in Aperio ImageScope DX from your organization’s medical device data system (MDDS). For information and 
instructions on using your MDDS, contact your site administrator.

Aperio ImageScope DX Window Overview
This example shows the Aperio ImageScope DX window with the main tools identified. 
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Aperio ImageScope DX Quick Reference
This section provides a description of the areas and tools shown in the example on the previous page. The numbers in the 
left column below correspond to the numbers in the example on page 9.

Feature Description

1 Slide Tray The Slide Tray contains all of the scanned eSlides associated with the case. You use the Slide Tray 
to open eSlides in the Viewer window. See "The Slide Tray" on page 13.

2 Viewer window The Viewer window displays the open eSlides. You view, navigate, and annotate eSlides in the 
Viewer window. 

3 Menu The menu provides access to commands, tool visibility, and options. 

4 Active eSlide The active eSlide is the eSlide open in the Viewer window. If multiple eSlides are open in the 
Viewer window, the active eSlide is the one that is currently selected.

5 Image toolbar The Image toolbar contains tools for viewing eSlide information, taking a snapshot, and 
synchronizing the navigation when viewing multiple eSlides. To show the Image toolbar, go to the 
View menu, select Toolbars, and select Image. 

The following tools are available:

Information
Displays detailed data about the scanned eSlide image. See "View 
Detailed Data for an eSlide" on page 16.

Snapshot
Takes a screen shot of the current view, and allows you to save it as a 
TIFF file. See "Save a Snapshot of the eSlide" on page 29.

Synchronize
Synchronize navigation of all open eSlides. See "Synchronize 
Navigation of Multiple eSlides" on page 31.
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Feature Description

6 Annotation 
toolbar

The Annotation toolbar contains tools you use to pan, zoom, and annotate the eSlide. To show the 
Annotation toolbar, go to the View menu, select Toolbars, and select Annotation. The following 
tools are available:

Pan and Zoom Pan through the eSlide or double-click to zoom in and out.

Pen Draw a freehand annotation.

Ruler 
Measurement

Create a measurement annotation of an area of interest.

Rectangle Draw a rectangle or hold down the Shift key to draw a square.

Ellipse Draw an oval or hold down the Shift key to draw a circle.

Counter Mark the eSlide with numeric counters.

Observation Pin Mark areas of interest on the eSlide. 

Annotation 
Color Picker

Change the color of annotations.

Copy annotation Copy the selected annotation. 

Paste 
annotation

Paste the copied annotation into the eSlide.

Previous 
annotation

Go to the previous annotation.

Next annotation Go to the next annotation.

See "Annotate eSlides" on page 23 for more information on using annotations.
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Feature Description

7 View toolbar The View toolbar is where you can expand the view to full screen and show or hide navigation and 
zoom tools. To show the View toolbar, go to the View menu, select Toolbars, and select View. 
The following tools are available:

Go to full-screen view. 

Click to show or hide the Scalebar, Axes, or Axes and Grid. 

Show or hide the Zoom Slider.

Show or hide the eSlide Label Image.

Show or hide the Thumbnail.

Show or hide the Rotation Dial.

8 Thumbnail Shows a representative view of the entire eSlide. Use the Thumbnail to navigate around the eSlide. 
See"Thumbnail" in the table under"View Different Areas of the eSlide" on page 15.

9 Thumbnail 
Navigation box

Represents the area currently shown in the Viewer window. Drag the box around the Thumbnail to 
view the corresponding area of the eSlide. See "Thumbnail Navigation box" in the table under "View 
Different Areas of the eSlide" on page 15.

10 Zoom slider Enables you to select a specific zoom level or manually zoom in and out of the eSlide. See "Change 
the Viewing Zoom Level" on page 16.

11 eSlide Label The image of the label on the glass slide. The eSlide Label appears if a photo of the glass slide 
label is associated with the eSlide.  

12 Status Bar Contains details about the current display. 

13 Aperio 
ImageScope DX 
indicator

This symbol indicates that you are working in the Aperio ImageScope DX viewer.

14 Rotation Dial Rotates the eSlide from 0 to 360°. See "Rotate the eSlide" on page 27.

15 Scale Bar Represents the scale of the eSlide in microns or millimeters, depending on the current zoom level. 
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Feature Description

16 Monitor status A green check mark means that the monitor connected to your viewing station is the 
correct medical-grade calibrated monitor for the Aperio AT2 DX System, and that the 
monitor and viewing station are configured correctly. 
A red X appears if the color profile settings on your viewing station monitor is incorrect, or 
if someone attempts to calibrate the monitor with a third-party software. Your eSlides will 
not display unless the monitor and viewing station are configured correctly. 

A red X also appears if you attempt to use Aperio ImageScope DX with a monitor other 
than the monitor approved for the Aperio AT2 DX System.

The Slide Tray
The Slide Tray contains all of the eSlides associated with the open case. 

Work with eSlides in the Slide Tray
The following describes the tasks you can perform in the Slide Tray.

To do this: Follow these steps:

View an eSlide. Click an eSlide to open it in the Viewer window.
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To do this: Follow these steps:

Enlarge the eSlide view. Point to an eSlide in the tray.

If you do not want eSlides to enlarge when you point to them, clear the Display 
Hover Popups for Images check box in the Viewer options. See "Viewer 
Options" on page 36. 

Open multiple eSlides.
Click the circle next to the eSlide you want to open. A pushpin  in the circle 
indicates the eSlide is open and “pinned” in the Viewer window.

To close the pinned eSlide, click the circle again. You can open up to four eSlides 
at one time. See "Open Multiple eSlides" on page 30.

Flip an eSlide horizontally to mark it as 
read or unread.

By default, eSlides are flipped in the tray after you read them. To manually flip 
the eSlide, right-click an eSlide and select Flip Slide. 

Flag an eSlide. To flag an eSlide for follow-up, right-click an eSlide and select Flag. A small red 
flag appears in the Slide Tray:

To remove the flag, right-click the eSlide in the Slide Tray and select Flag.
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To do this: Follow these steps:

View eSlides that have annotations. In the Slide Tray, look for eSlides with a pencil symbol. The pencil appears on 
eSlides that have annotations.

 

View a different Slide Tray for the 
open case.

If there is more than one Slide Tray for the case, click the <<Prev and Next>>  
links at the bottom of the Slide Tray. 

Hide the Slide Tray to expand the 
Viewer window.

Click the Slide Tray arrow in the upper-right of the Slide Tray: 

To view the Slide Tray, click the arrow again.

View Different Areas of the eSlide
The following describes different ways to move around the eSlide.

Use the 
Thumbnail

The Thumbnail shows the entire eSlide. The small navigation box represents the area that currently 
appears in the Viewer window. 

To move around the eSlide using the Thumbnail, do one of the following:

yy Drag the navigation box around the Thumbnail to view the corresponding areas of the eSlide. 

yy Click inside the main Thumbnail to move to the corresponding area on the eSlide.

You can also track your navigation in the Thumbnail. See "Track Pan and Zoom Navigation With the 
Track Map" on page 29.
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Manually pan 
around the 
eSlide

Click the Pan and Zoom tool , and drag your mouse pointer to move around the eSlide.

You can set an option to reverse the panning direction (pathologist mode). See "Navigation Options" 
on page 36.

Scrolling Point to the edge of the Viewer window.  When the pointer changes to an arrow , hold the mouse 
button to scroll in the direction of the arrow. Release the mouse button to stop scrolling.

Change the Viewing Zoom Level
You can use any of the following methods to change the zoom level of the eSlide.

Use your mouse 
to zoom in and 
out

Do one of the following:

yy Click anywhere on the eSlide, and then rotate the mouse wheel button up to zoom out farther, 
and down to zoom in closer.  

yy Double-click anywhere on the eSlide to go to the maximum zoom level (highest resolution). 
Double-click again to return to the previous zoom level.

Use the Zoom 
Slider

Click the Zoom buttons (Fit, 4x, 10x, and so on) to select a specific zoom level, or drag 
the slider to manually adjust the zoom. Click Fit to display the entire eSlide in the Viewer 
window.

The maximum zoom available (20x or 40x) depends on the magnification at which the slide 
was scanned. The highest number on the Zoom Slider is the scan magnification. In this 
example, the slide was scanned at 20x.

View Detailed Data for an eSlide
Click the Information  tool to display detailed data for the active eSlide.

The Information tab contains eSlide metadata. Click the Thumbnail, Label, and Macro tabs for different views of the 
eSlide.

Image Rendering
When you pan, rotate, or otherwise change the view of the eSlide, the "Rendering" message may appear. This means 
ImageScope DX is still adjusting the eSlide image, and you should wait until the message disappears before reviewing the 
eSlide for diagnostic purposes.
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Keyboard Shortcuts
This section contains a quick reference list of keyboard shortcuts you can use with ImageScope DX.

Key Sequence Menu Command Tool Action

Arrow keys None None
Nudge image left, right, up, and down.

Note: Pan and Zoom   must be active to move the 
image with the Arrow keys.

Ctrl + Plus key None None Zoom in.
Ctrl + Minus key None None Zoom out.

Ctrl None None
Press while drawing an annotation to draw the annotation 
in a predefined size.

Ctrl + C Annotations > Copy None

yy Take a screen shot of the current view: Press Ctrl + C, 
then paste the image into Paint or another application. 

yy Copy and paste an annotation into the same eSlide: 
Selected an annotation, press Ctrl + C, click inside the 
eSlide and press Ctrl + V to paste the annotation. 

Ctrl + F4 File > Close Case None Closes the image currently open in ImageScope.

Alt + F4 File > Exit Closes ImageScope DX.

Ctrl + M
Image > Manual 
Synchronization

Activates Manual Synchronization.

Ctrl + P

Tools > Navigation, 
Annotations, Viewer, 
Tracking, or Monitor 
Quality Check

None
Opens the Options window to set navigation, annotation, 
viewer, and tracking options. The Monitor Quality Check 
option enables you to perform a visual monitor check.

Ctrl + Shift None None
Press while using the arrow keys to move the selected 
annotation.

Ctrl + T View > Thumbnail None Shows or hides the Thumbnail window.
F1 Help > ImageScope Help None Opens ImageScope DX help.

F2 Annotations > Pen Activates the Pen drawing tool.

F4
Annotations > Ruler 
Measurement

Activates the Ruler Measurement drawing tool.

F5 Annotations > Rectangle Activates the Rectangle drawing tool.

F6 Annotations > Ellipse Activates the Ellipse drawing tool.

F9
Annotations > Counter 
Tool

Activates the Counter annotation tool.

F10
Annotations > 
Observation Pin

Activates the Observation pen annotation tool.

F11 View > Full Screen None Expands ImageScope DX to a full-screen view.
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Key Sequence Menu Command Tool Action

Shift None None
Press while drawing annotations: ellipse becomes a circle; 
rectangle becomes a square.

Shift + Arrow key None None

Moves image left, right, up, and down one screen width at 
a time.

Note: Pan and Zoom   must be active to move the 
image with the Arrow keys.

Shift + Ctrl None None
Press while drawing an annotation to create a region of the 
same aspect ratio as the predefined fixed annotation size.

Close Aperio ImageScope DX
To close Aperio ImageScope DX, go to the File menu, and select Exit. You can also click  in the upper-right corner of 
the Aperio ImageScope DX window.
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3 Basic eSlide Viewing

This chapter provides instructions on using Aperio ImageScope DX to read eSlides. 

Before You Begin
Before you can review eSlides using Aperio ImageScope DX:

`` Use the Aperio AT2 DX scanner to scan the glass slides for the case you want to review. See the Aperio AT2 DX 
User’s Guide for instructions.

`` Ensure the eSlides scanned on the Aperio AT2 DX are available in your MDDS. 

Open Case eSlides in Aperio ImageScope DX
You can open one case at a time in Aperio ImageScope DX. When you open a case from your MDDS, Aperio ImageScope DX 
automatically closes any previously opened case before it opens your next case. 

It takes less time to open the eSlides for your case if Aperio ImageScope DX is already open. To achieve 
optimum image loading performance when opening cases in ImageScope DX, we recommend that you 
leave Aperio ImageScope DX open during your viewing session. 

To open all of the eSlides associated with a case:

1.	 Following the instructions for your institution’s MDDS to open the case.

When Aperio ImageScope DX opens, all of the eSlides for the case appear in the Slide Tray. The first eSlide in the 
tray opens in the Viewer window. 
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2.	 With the case opens in Aperio ImageScope DX, you can do the following:

`` Perform Quality Control on the eSlides scanned for the case. See”eSlide Quality Control” on page 20 . 

`` View the eSlide and change the zoom level (pan and zoom). See “Basic eSlide Viewing” on page 20.

`` View one or more eSlides using advanced viewing techniques. See “Chapter 4: View and Annotate 
eSlides” on page 23.

`` Draw annotations on the eSlide to indicate areas of interest. See “Annotate eSlides” on page 23.

Close a Case in Aperio ImageScope DX
To close the eSlides for a case without closing Aperio ImageScope DX, go to the File menu, and select Close Case. 

Note that Aperio ImageScope DX closes a previously opened case when you open a new case. 

eSlide Quality Control
The scanning technician should perform quality control on the glass slides and eSlides during the scanning process. The 
pathologist must also perform quality control on the eSlides. 

To assess the quality of the slide preparation, follow the instructions for the specific staining protocol. 

To perform quality control on the eSlides, follow these steps: 

1.	 Open the eSlides in Aperio ImageScope DX.

2.	 Look at the entire image, including the perimeter of the eSlide, to confirm that the entire tissue sample was 
scanned.

3.	 Adjust the magnification using the Zoom tool. Click the thumbnail in the ImageScope window and pan the image.

4.	 All eSlides should be in focus and free of visible image stripes.

5.	 Rescan any eSlides that failed to scan or failed the image quality review.

If an eSlide has poor quality in any of the above areas, you may need to request a new slide or a re-scan of the slide. 

For more details about preparing glass slides for scanning, see the Aperio AT2 DX User’s Guide. 

Basic eSlide Viewing
Use the Aperio ImageScope DX navigation tools to move around the eSlide and to view areas of the eSlide at different zoom 
levels. You do not need to focus the eSlide. Optimum focus is determined when the slide is scanned.

The steps below describe one method of reviewing eSlides:

1.	 Adjust the zoom to 4x and pan through the eSlide to look for areas of interest. 

2.	 When you find an area of interest, adjust the zoom to 20x or 40x to assess the area. 

3.	 Return to a lower zoom level and continue panning through the eSlide to look for more areas of interest.

The next section provides detailed steps for this viewing method.
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View an eSlide
To view an eSlide using the method described previously, follow these steps:

1.	 With the eSlide open in Aperio ImageScope DX, set the zoom to 4X by clicking 4x on the Zoom Slider. 

2.	 Click the Pan and Zoom tool .

3.	 Drag the mouse pointer in any direction to pan around the eSlide.
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4.	 When you find an area of interest to review, click 20x or 40x to zoom in closer. (The maximum zoom available 
depends on the magnification of the original scanned image. The greatest number on the Zoom Slider is the scan 
magnification. In this example, the slide was scanned at 20x.)

5.	 Click 4X to zoom out again and continue panning.

See “Chapter 4: View and Annotate eSlides” on page 23 for information on advanced viewing techniques and adding 
annotations.
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This chapter provides information on viewing and annotating eSlides using Aperio ImageScope DX. 

Annotate eSlides
Use annotations to mark an area of interest on an eSlide or to measure an object.

You use the Annotation toolbar to select the annotation tool you want to use. To show the Annotation toolbar, go to the 
View menu, select Toolbars, and select Annotation.

When you use an annotation tool, it stays active until you click another tool to use. After drawing an 
annotation, you need to click the Pan tool  to move to other areas of the eSlide or to select an 
annotation.

Draw Annotations
The following table describes the types of annotations you can draw on an eSlide. 

To do this Follow these steps Example
Draw a free-form shape 1.	 Click the Pen tool  . 

2.	 Drag your mouse pointer to draw the annotation 
in any shape. 

To edit an annotation drawn with the Pen tool, see 
"Edit Free-Form Annotations Drawn with the Pen Tool" 
on page 26.

4 View and Annotate eSlides
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To do this Follow these steps Example
Measure an object

1.	 Click the Ruler Measurement tool . 

2.	 Point to the object you want to measure, and drag 
the ruler across the object. 

The measurement appears on the eSlide. The unit 
of measure adjusts to the current zoom level. For 
example, a line that appears in microns at 20x 
may appear in millimeters at lower zoom level.

Draw a rectangle or 
square

1.	 Click Rectangle tool .

2.	 Drag your mouse pointer to draw a rectangle. To 
draw a square, press and hold the Shift key as 
you draw.

Draw an ellipse or circle 1.	 Click the Ellipse tool . 

2.	 Drag your mouse pointer to draw an ellipse. To 
draw a circle, press and hold the Shift key as you 
draw.

Add a counter 1.	 Click the Counter tool . 

2.	 Click to mark the eSlide with numbered 
annotations. Counters are numbered 
automatically in the order they are placed. 

Add an observation pin
1.	 Click the Observation Pin tool .

2.	 Click to mark areas of interest on the eSlide. 
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You can access many of the annotation tools by right-clicking the eSlide, 
and selecting from the menu.

Delete an Annotation
To delete an annotation:

1.	 Click the Pan and Zoom tool .

2.	 Select the annotation you want to delete, and press the Delete key.

3.	 Click Yes at the prompt.

View eSlides With Annotations
A pencil appears in the Slide Tray when there are annotations on the corresponding eSlide.

  

Change the Color of Annotations
You can change the color of new annotations. Annotations drawn previously remain in their original color. 

To change the color of annotations:

1.	 Click the Annotation Color Picker tool .

2.	 When the Color window opens, click the color you want to use and click OK. 

You can also click Define Custom Colors to define and save a custom color. 

Copy and Paste Annotations
The Copy Annotation and Paste Annotation tools are active when an eSlide contains annotations. You can copy an 
annotation and paste it into the same eSlide.

To copy and paste an annotation within the same eSlide:

1.	 Click the Pan and Zoom tool .

2.	 Select the annotation you want to copy, and click the Copy tool . 

3.	 Click the Paste tool . The duplicate annotation moves with your mouse pointer.

4.	 Click to place the annotation in the eSlide. 
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Move From One Annotation to the Next
The Previous Annotation and Next Annotation tools are active if there are multiple annotations on the eSlide. 

To move through the annotations, click the Previous  and Next  tools. The active annotation appears centered in 
the Viewer window.

Draw Annotations With a Fixed Size or Fixed Aspect Ratio
You can set a fixed size for annotations in the Aperio ImageScope DX options. The instructions below describe how to draw 
annotations using the fixed size. 

Draw an Annotation with a Fixed-Size
Press the Ctrl key while drawing the annotation. 

This feature works with rectangle and ruler measurement annotations only. You set the fixed size in the Aperio ImageScope 
DX Options.

For information on setting the fixed size for annotations, see "Annotation Options" on page 36.

Draw an Annotation with a Fixed Aspect Ratio
You can draw an annotation that uses the same aspect ratio (width and height proportion) as the fixed annotation size 
defined in the Aperio ImageScope DX options. To do this, press the Shift + Ctrl keys while you draw the annotation.

Edit Free-Form Annotations Drawn with the Pen Tool
You can edit the shape of free-form annotations drawn with the Pen tool. You can edit an existing annotation or finish an 
incomplete annotation. 

Tips for redrawing annotations: 

yy Drag the pointer in a slow and smooth manner.    

yy Refine your edits as needed by dragging the pointer back and forth over the same area.

Complete or Edit a Free-Form Annotation
1.	 Select the annotation, and then click the Pen tool . 

2.	 Point the Pen tool where you want to start the edit.

3.	 Hold the left mouse button and slowly drag the line to connect two ends or to change the shape of the annotation. 

4.	 When you are finished editing the annotation, release the mouse button.
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The following examples show two ways to edit annotations.

To do this: Draw like this:
Complete an 
annotation: 

Edit an annotation:

Change eSlide Views
This section describes how to perform some common navigation tasks. 

Rotate the eSlide
To rotate the eSlide from 0° to 360°, drag the arrow around the Rotation Dial. The number in the center indicates the current 
rotation. 

To rotate the eSlide in 1 degree increments, click the left and right arrows at the bottom of the dial.
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Annotate a Rotated eSlide
When you rotate the eSlide, any existing annotations are rotated with the eSlide. If you draw new annotations on the 
rotated eSlide, they are drawn relative to your current view. In the example below, the annotation on the right was drawn 
before the eSlide was rotated. The annotation on the left was drawn after the eSlide was rotated.

Rotate the eSlide Label
Click the eSlide label to rotate it 90°. 

The system saves the eSlide label rotation when you save the eSlide.
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Save a Snapshot of the eSlide
The Snapshot tool enables you to take a picture of the current view of the eSlide, and save it as a TIFF file for use in reports 
and presentations. The saved image includes annotations. 

WARNING:  THE SNAPSHOT IMAGE (TIFF FILE) IS FOR RESEARCH USE ONLY. NOT FOR 
USE IN DIAGNOSTIC PROCEDURES.

To take a snapshot:

1.	 Open the eSlide to the view and zoom level you want to capture in the snapshot.

2.	 Go to the Image toolbar, and click the Snapshot  tool.

3.	 In the Save Snapshot window, specify the file location and name, and then click Save to save the image. 

You can open the saved TIFF file in Aperio ImageScope DX; however, note that the pan and zoom 
features are not available when viewing TIFF files.

Track Pan and Zoom Navigation With the Track Map
The track map appears in the Thumbnail, and shows the areas of the eSlide you have viewed. 

The opacity of the track map and the size of the tracks indicate the zoom level 
used.  

The example shows three lines of tracks, each made at a different zoom level 
(20x, 10x, and 4x, from top to bottom). 

You can turn on Tracking by default. You can also determine how the track 
map evaluates the eSlide. See "Track Pan and Zoom Navigation With the 
Track Map" on page 29 and "Tracking Options" on page 37.

Clear the Track Map
To clear the track map, right click in the thumbnail and select Clear Map.
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Open Multiple eSlides
You can open up to four eSlides at a time.

Follow these steps to open and view multiple eSlides in the Aperio ImageScope DX Viewer window:

1.	 Click the circle next to each eSlide you want to open. Selected images appear in the Slide Tray with push pin  
in the circle, as shown below.

The selected eSlides open in the Viewer window, along with the eSlide that was already open.

2.	 To close an eSlide, go to the Slide Tray and click the circle  again.
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Synchronize Navigation of Multiple eSlides
The Synchronize tool enables you to pan and zoom all open eSlides simultaneously. As you pan and zoom in one eSlide, the 
other eSlides follow the same navigation behavior.

The Aperio ImageScope DX Navigation options determine the default synchronization behavior. You 
can define whether the system synchronizes eSlide navigation only when you pan, only when you 
zoom, or when you pan and zoom. See "Navigation Options" on page 36.

To view multiple eSlides using synchronized navigation:

1.	 Open the eSlides you want to view. You can open up to four images at one time.

2.	 Click the Pan and Zoom tool .

3.	 Go to the Image toolbar and click the Manual Synchronization tool . 

4.	 Pan and zoom through the active eSlide. 

Viewing a Z-Stack eSlide
The Aperio AT2 DX scanner can create multiple digital images of slide tissue scanned at different focal depths. This process 
creates a 3D image that you can visually navigate through, as a microscope user navigates through different tissue focal 
depths using the microscope objective fine and coarse adjustments. This ability to create a 3-D image is called “z-stack 
scanning.”

Aperio ImageScope DX enables you to view and annotate specific layers of the z-stack image. 

Viewing and Navigating a Z-Stack Image
Aperio ImageScope DX automatically opens a z-stack image to the best focused layer, as determined by your scanner when 
the slide is scanned. The number of layers and the layer separation (depth, in microns (µm), between the layers) is set during 
scanning. For more information on scanning z-stack images, see the Aperio AT2 DX User’s Guide.
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The Focus slider, shown below, only appears on z-stack eSlides. You use this tool to view different z-stack layers.

Viewing Different Z-Stack Layers
`` Drag the Focus slider up and down to view different layers of the z-stack image. The number at the bottom of the 

slider represents the current focus point.
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`` Click  to view image information, including information for each z-stack layer.

Drawing and Viewing Annotations on a Z-Stack eSlide
Annotations are stored on the z-stack layer on which you draw them. Annotations are visible from all z-stack layers.

To draw annotations on a z-stack eSlide:

1.	 Drag the Focus slider to the desired z-stack layer.

2.	 From the Annotation toolbar, select the annotation tool you want to use.
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3.	 Draw your annotation. 

Viewing Annotations On Different Z-Stack Layers
To navigate through annotations on a z-stack eSlide, use the Next and Previous buttons . 

As you navigate to each annotation, the system adjusts the eSlide view to the corresponding z-stack layer. 

You must use the Next and Previous buttons if you want to view the annotations on their z-stack 
layer. If you select the annotations manually by clicking them, the z-stack layer view is not adjusted.
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5 Aperio ImageScope DX 
Options

This chapter describes the default options you can set for Aperio ImageScope DX. It also contains 
instructions for performing a visual quality check on your monitor.

View the Aperio ImageScope DX Options
To view or set Aperio ImageScope DX options, go to the Tools menu and select the option you want to view: Navigation, 
Annotations, Viewer, Tracking, or Monitor Quality Check.  

The following example shows the Navigation options.

See the following sections for a description of the available options.
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Navigation Options
Click the Navigation tab to view or edit the following options:

Synchronization This setting determines the default behavior for synchronized navigation. The Synchronize tool 
enables you to apply the same pan and zoom behavior to multiple eSlides at the same time. 

Select one of the following options:

yy Pan and zoom

yy Pan only

yy Zoom only

For details on using synchronized navigation, see “Synchronize Navigation of Multiple 
eSlides” on page 31. 

Panning Drag the slider to adjust scroll and pan speeds:

yy Scroll Speed specifies the how fast the image moves when you are using the scrolling 
feature. See“Scrolling” in the table on page 16.

yy Pan Speed specifies how fast the image moves when you manually drag the image. 

Select the Reverse panning direction (pathologist mode) check box to pan in reverse. 
With reverse panning, when you drag the mouse pointer to the left the image moves to the 
right.

Annotation Options
Click the Annotations tab to view or edit the Fixed Size Regions options. Type in the Width, Height, and Length using 
pixels or microns. 

These settings enable you to draw annotations that match the size you set. To draw a fixed-size annotation, press and hold 
the Ctrl key while drawing a rectangle or square. See “Draw Annotations With a Fixed Size or Fixed Aspect Ratio” on page 
26. 

Viewer Options
Click the Viewer tab to view or edit the Display Hover Popups for Images option. This option is enabled by default. If 
this option is enabled, you can point to an eSlide in the Slide Tray to view an enlarged version of the eSlide.
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Tracking Options
The Tracking settings work with the Track Map in the Thumbnail. For more information on using the tracking feature, see 
“Track Pan and Zoom Navigation With the Track Map” on page 29.

Click the Tracking tab to view or edit the Track Map Settings:

Automatically display track 
map

Displays tracks in the Thumbnail as you pan around the eSlide. It also displays 
any previous tracks made in this eSlide. 

Minimum Resolution Specifies the minimum resolution of a view that is mapped. This defines the 
lowest resolution at which a region of the image is viewed.

Minimum Magnification Specifies the minimum magnification of a view that is mapped. This defines the 
lowest magnification at which a region of the image is viewed. 

Monitor Quality Check
The Monitor Quality Check tab enables you to open a test pattern image to check the display quality of your monitor. 
You should check this test image once a month. See “Appendix A: Perform a Monitor Quality Check” on page 38 for 
complete instructions.

Leica Biosystems Technical Services also uses this image for troubleshooting and maintenance purposes. 



Aperio ImageScope DX User’s Guide, Revision A © Leica Biosystems Imaging, Inc. 201938

This appendix describes how to perform a visual quality check on your Aperio AT2 DX Viewing Station 
monitor. 

We recommend performing a visual quality check on your monitor once a month. 

You check the monitor quality by evaluating a special test image. Familiarizing yourself with the test image when you first 
use the system may help you more readily identify any changes in the image in the future.

Follow these steps to evaluate the test image:

1.	 On your Aperio AT2 DX Viewing Station, open Aperio ImageScope DX.

2.	 Go to the Tools menu, and select Monitor Quality Check. The Monitor Quality Check tab opens.

3.	 Click Open Monitor Quality Check Image.

The test pattern image appears in your Aperio ImageScope DX window. 

A Perform a Monitor Quality 
Check
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The test image appears on a calibrated monitor with a higher level of clarity than this example. 

The colored outlines and numbers are not part of the test image. They are included here to 
identify the areas to evaluate.

1 1

2

33

2 2

4.	 Check for the following items on the test image.

Test Graphic Area: What to Check:

1   
Vertical gradient bars 
outlined in Blue.

`` Changes in intensity are smooth and uniform over the entire range of bright 
to dark. 

`` There are no noticeable bands of constant intensity (solid white, gray, or 
black) inside or near the edges of the bars.

2 Upside down U-shape 
outlined in Yellow.

`` Following the direction of the yellow arrows in the example (from white to 
black), the change in intensity from one square patch to the next increases 
by the same relative amount.
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Test Graphic Area: What to Check:

3 Squares outlined in 
Green.

`` The small 95% grayscale square patch inside the black square is clearly 
visible at normal viewing distance (30 - 60 cm). 

`` The small 5% grayscale square patch inside the white square is clearly 
visible at normal viewing distance (30 - 60 cm).

5.	 If you notice an issue with any of the test image evaluations, contact Leica Biosystems Technical Services.

6.	 To close the test pattern image, go to the File menu and select Close Case.



Aperio ImageScope DX User’s Guide, Revision A © Leica Biosystems Imaging, Inc. 2019 41

The 3Dconnexion SpaceMouse® Pro is a three-dimensional input device that is available as an option for 
your Aperio AT2 DX System. 

This section shows how the buttons on the optional 3Dconnexion SpaceMouse Pro map to Aperio ImageScope DX 
navigation tools. There is some setup required to use the SpaceMouse Pro device with ImageScope DX. See“Set Up the 
SpaceMouse Pro” on page 42 for instructions. For general use instructions, see the documentation and tutorials provided 
with your SpaceMouse Pro mouse. 

1

2 3

4

5

6

7

9

8

10

11

12

1 View at 2x (20x image) or 4x (40x image) 6 Place an observation pin annotation 11 Push down to zoom in
Pull up to zoom out
Turn to rotate by 1 degree increments
Move to pan

2 View at 5x (20x image) or 10x (40x image) 7 Lock or unlock rotation (see page 43)

3 View at 10x (20x image) or 20x (40x image) 8 View the next slide in the tray

4 View at 20x (20x image) or 40x (40x image) 9 View the previous slide in the tray 12 View layers on z-stack images (see 
page 43)5 Rotate 90 degrees clockwise 10 View at Fit (fit eSlide to screen)

B 3-D Mouse Quick Reference
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Set Up the SpaceMouse Pro
You need to map buttons 1 through 4 on the SpaceMouse Pro device before you can use it with ImageScope DX. The other 
buttons are already mapped. Note that the 3Dconnexion drivers come installed on your Aperio AT2 DX Viewing Station.  

To map buttons 1 through 4:

1.	 On your Aperio AT2 DX Viewing Station, open Aperio ImageScope DX.

2.	 Connect the SpaceMouse Pro device to your Aperio AT2 DX Viewing Station.

3.	 On the SpaceMouse Pro device, press the Menu key to open the properties panel.

4.	 Ensure that “ImageScope.exe” appears in the header of the SpaceMouse Pro properties panel, as shown below. If 
you don’t see “ImageScope.exe,” make ImageScope DX the active window by clicking in the Aperio ImageScope 
DX window using your standard mouse.

5.	 In the SpaceMouse Pro properties window, click Buttons.

6.	 To map buttons 1 through 4:

a.	 Click  on the action box for button 1, select 3DConnexion, and select Application Use.
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b.	 Repeat the previous step for buttons 2 through 4.

When you finish assigning buttons 1 through 4, “Application Use” appears as the action for each button:

7.	 To save your mappings, close the SpaceMouse Pro software. Click Close in the Buttons window, and then click 
Close in the properties window. 

8.	 The SpaceMouse Pro is now ready to use with Aperio ImageScope DX.

Rotate the eSlide with the SpaceMouse Pro Device
To rotate the eSlide:

1.	 Press the Rotate button  on your SpaceMouse Pro device to turn on the rotation feature.

2.	 Turn the Controller Cap to rotate the eSlide.

3.	 When you are finished rotating the eSlide, press the Rotate button  on your SpaceMouse Pro device to turn 
off the rotation feature.

Navigate a Z-Stack Image with the SpaceMouse Pro Device
To view different layers of a z-stack image:

1.	 Press and hold the ALT key on the SpaceMouse Pro device or your keyboard. 

2.	 Turn the controller cap to view the different z-layers.
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A
active eSlide  9, 10
annotate eSlides  23
annotations

change color  25
copy and paste  25
delete  25
draw  23
edit freehand  26
in eSlide Tray  25
set fixed aspect ratio  26
set fixed size  26
types and examples of  23

Annotation toolbar  9, 10, 23. See also Annotation tools
Annotation tools

copy and paste annotations  11, 25
Counter  11, 24
custom color  25
Ellipse or Circle  11, 24
Observation Pin  24
Pen  23
Rectangle or Square  11, 24
Ruler Measurement  24

Aperio AT2 DX Viewing Station
viewing test image  38

area of interest, view  22
axes, show or hide  12

B
best focused layer, z-stack  31

C
camera tool. See Snapshot tool
case

view eSlides  13

change eSlide rotation  27
clear track map  29
close

Aperio ImageScope DX  18
eSlide Tray  15

color
custom for annotations  25
set for annotations  25

copy annotations  11, 25
Counter annotation  11, 24

D
data, eSlide  16
delete annotations  25
draw annotations  23

E
edit pen annotations  26
Ellipse annotation  11, 24
eSlide

active  9
close  30
data  16
enlarge in tray  14
flag  14
flip horizontally  14
information, view  10
macro image  16
mark as read or unread  14
metadata  16
navigate  16
open multiple  14
pan and zoom  16
view  13

eSlide Label  16

Index
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Index

description  12
example  9
rotate  28
show or hide  12

eSlides
basic viewing  19, 20, 21
open multiple  30
rotate  27

eSlide Tray  13, 19
description  10
enlarge eSlide  14
example  9, 13
expand or collapse  15
flag eSlide  14
using  13
view other eSlide Trays  15

expand screen  12

F
fast scroll  16
file types supported  7
fixed aspect ratio annotations  26
fixed-size annotations  26
flag symbol  14
flip eSlide in eSlide Tray  14
free-form shape, draw  23
Full-screen view  12

G
grid, show or hide  12

H
hide eSlide Tray  15

I
image file, save. See Snapshot tool
ImageScope DX

close  18
example screen  9
indicator  9, 12
overview  9

Image toolbar  9, 10. See also Image tools
Image tools

eSlide information, view  10

Snapshot  10
Synchronize  10, 31

image types supported  7
Information tool  10
input device, optional 3-D mouse  41
Intended Use statement  7

K
keyboard shortcuts  17

M
macro image, eSlide  16
magnification  16
manuals, list  9
mark eSlide as read  14
maximum zoom level  22
measurement annotation. See Ruler Measurement 
annotation
Menu  9, 10
metadata, eSlide  16
monitor quality check  38
monitor, supported  8
mouse, 3D  41

N
navigate multiple eSlides  31
navigate, use Thumbnail  15
navigating

z-stack images, scanned  31
navigation box, Thumbnail  9
non-cleared viewers  7
numbered annotation. See Counter annotation

O
Observation Pin annotation  24
open

eSlide Tray  15
multiple eSlides  14

overview
Aperio ImageScope window  9
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Index

P
Pan and Zoom tool  12
pan around eSlide  16
paste annotations  11, 25
Pen annotation  11, 23
pencil, eSlide Tray  15, 25
picture, take of eSlide. See Snapshot tool
pin drop annotation. See Observation Pin annotation
pin symbol  30
pre-set annotation size  26
pushpin symbol  30

Q
quality check, monitor  38
quality control, eSlide  20

R
read eSlides  19, 20, 21
Rectangle annotation  11, 24
redraw freehand annotation  26
rendering message  16
reset track map  29
restrictions for DX image viewing  7
rotate

eSlide  27
eSlide label  28

Rotation Dial
example  9
rotate eSlide  27
show or hide  12
Use with SpaceMouse Pro  43

Ruler Measurement annotation  24

S
Scale Bar

description  12
example  9
show or hide  12

scan magnification  16, 22
Scanning Technician  20
scan slides. See Aperio AT2 DX User’s Guide
screen, expand  12

screen shot. See Snapshot tool
Scroll feature  16
shortcuts, keyboard  17
Zoom Slider  12
simultaneous eSlide viewing  31
slide preparation  20. See also Aperio AT2 DX User’s 
Guide
Slide Tray  13
Snapshot tool  10, 29
SpaceMouse Pro

map buttons  42
navigate z-stack layers  43
quick reference  41
rotate eSlide with  43

square annotation  24
Status Bar  9
SVS files, supported  7
synchronize eSlide viewing navigation  31
Synchronize tool  10

T
test image, monitor quality check  39
Thumbnail

description  12
example  9
image, Information window  16
navigate  15
navigate eSlide  15
show or hide  12
track map  29

Thumbnail Navigation Box
description  12
example  9
move in Thumbnail  15

TIFF files, viewing  7, 29
toolbars

Annotation  9
example  9
Image  10
View  12

track map
clear  29
use  29
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Index

tray, slide  13

V
Viewer window  9, 10
View eSlide

Thumbnail  15
view eSlides  20
view multiple eSlides  30, 31
View toolbar  9, 12. See also View tools
View tools

eSlide Label  12, 28
Full-screen  12
Rotation Dial  12, 27
scalebar, axes, grid  12
Thumbnail  12, 15
Zoom Slider  12

W
window, make full-screen  12

Z
zoom and pan multiple eSlides  31
zoom in eSlide  16
zoom level  16

change  16
maximum  22

Zoom Slider
description  12
example  9, 16
zoom in and out  16

z-stack images
best focused layer  31
navigate with SpaceMouse Pro  43
viewing  31
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Symbols
ÌÌ The following symbols may appear on your product label or in this user’s guide:

Consult instructions for use

Manufacturer

Date of manufacture

Authorized representative in the European Community

In vitro medical diagnostic device

Serial number

Catalog number

Relative humidity range

Biological risks

Temperature limit

Electronic and electrical equipment waste disposal

Caution

The lightning flash with arrowhead symbol within an equilateral triangle is intended to alert you to the presence of
uninsulated “dangerous voltage” within the product’s enclosure that may be of sufficient magnitude to constitute a
risk of electric shock to persons.

The flat surface with waves symbol within an equilateral triangle is intended to alert you to the presence of hot
surfaces which could cause burn damage.

The UV lamp within an equilateral triangle is intended to alert you to the presence of UV light within the
product’s enclosure that may be of sufficient magnitude to constitute a risk to the operator.
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